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Liswin – Introduction to the interactive electronic  catalog 

  Note  

Introduction to Liswin 

     LITESTAR 4D - Liswin is the interactive electronic catalog 
program module with search functions realized by means of 
different systems and parameters, for data processing to produce 
project documentation, and for automatic data updating.  

Liswin is a fundamental instrument for the modern designer 
because it accompanies him in his daily work, relieving him of 
those operations that are not pertinent to his own work. 

Interactive Catalog Management 
Selection of the Liswin function will open the catalog browser 
which is divided into the following parts: 

�� the upper part made up of three bands: the menu and icon 
bands 

�� a central part featuring the tree section and product list in the 
center 

�� a lower part consisting in various TABS that contain the data 
of the selected product 

�� a side bar with the images and polar curve of the selected 
product.  

 

Why Interactive ? 

Because it allows dynamic interaction between 
different systems, such as parametric product 
search management, data sheet management, 
interfacing with the WebCatalogs from which to 
download data by means of a simple mouse click 
(drag&drop function). 
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Function bars – Menu bar 

  Note  

The menu bar contains the following menus: 

�� File 

�� View 

�� Function 

�� Links 

�� Data 

�� About… 

File 
The File menu allows you to manage the following functions: 

�� Parametrical Search to search for one or more products 
according to the parameters defined by the operator in the 
relative dialogue window 

�� Manufacturer selection to select the manufacturers on which 
you intend to work from the complete list of available 
manufacturers 

�� Configuration for access to the parameter management 
section of the Liswin module, such as file paths or technical 
sheet colors 

�� Filter Activation to apply the DB filter. It is necessary to exit 
the program so that the filter can be applied on re-entry. The 
filter allows the database fields to be updated to include 
something new such as: a new color, a new norm, a new 
trademark etc…   

�� Exit to leave the Liswin module. To exit you can also press 
the X on the top right. 

�
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Function bars – Menu bar  
  Note  

View 
The View menu allows you to manage the following functions: 

�� Manufacturer Data to view the active manufacturer’s data 

�� Price List for access to price list management functions 

�� Currency to open the currency management window 

�� Products Elimination to activate the deletion of one or more 
products from the database 

�� Product List to activate management functions of the product 
lists to be used later with the estimate module (Lisman) 

�

Function 
The Functions menu allows you to manage the following functions: 

�� Find to search for a product according to the characters 
entered in the dialog window.  Search is carried out among 
the elements in the active column (the one showing the 
symbol of the triangle in its description)  

�� Find Next to search for the next product to that found with the 
Find function 

�� Technical Data Sheet for access to the management module 
of the data sheet of the selected product. It is also sufficient to 
click twice on the selected product 

�� Photometry to view, if the FOT indication to the left of the 
product is active, the luminaire photometry 

�� Documents for access to the window showing the list of 
documents associated with the selected product (Excel, PDF 
files etc.) 

�� Delete to eliminate the selected product from the catalog 

�� Product List to add the selected product to the project list 
which can then be imported with the Lisman program 

�� Edit to enter the Lisdat module to manage the data of the 
selected product 

�
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Function bars – Menu bar  
  Note  

Links 
The Links menu allows you to move from one LITESTAR program 
module to another with the following available links, shown in copy 
in the third icon bar, which are as follows:�

 

Litecalc  is the lighting engineering calculation program 
for interiors and exteriors (large areas, roads, tunnels) 
with viewing functions of results tables, graphs and 
photo-realistic images  of the area itself from different 
points of view, by means of ray-tracing and radiosity 
rendering.  

 
Photoview   is the photometry view module with view 
and print functions of photometric tables and graphs in 
different languages. 

 
Lisdat   is the catalog data management module with 
manual data entry or database import. 

  

  

Data 
The data menu concerns the functions for  managing and 
importing external data. 

 

About…  
This opens the window showing relative program data. 

�
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Function bars – Icon Bars  
  Note  

The program presents 2 icon bars thus formed: 

First icon bar 

A first drop-down menu from which to choose the type of product to 
be selected 

�� Luminaires 

�� Lamps 

The second drop-down menu shows the list of activated manufacturers. Select one to gain selective access to the database of that 
manufacturer. On the second bar, aligned on the right, appears the manufacturer’s logo, if present, or otherwise the name in text format. 

 
Access to the Parametrical Search function 

 
Delete selected products 

 
Access to the Technical Data Sheet management 
functions  

Icon with which to open the Price List window 

 
Icon with which to open the Currency window 

 
Access to Documents (product accessory files). 

The Documents function allows a series of documents 
associated with the selected product, if available, to be 
viewed; these may be documents of the following types 
DOC (Word), PDF (Acrobat), DXF or DWG, XLS: it is 
essential that the relative program or viewer is installed 

 
Icon with which to open the Manufacturer window 

 
Access to the Product List function 

 
Icon with which to open the Configuration window 

 
Access to the Products Elimination function 

 
Icon with which to open the Estimate module 

 
Add to list   

�
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Function bars – Icon Bars  
  Note  

Second icon bar 

The second icon bar is made up of  2 groups of icons. The first is that of the connected programs and the second that of the data update 
management functions. 

The first group includes: 

 
Litecalc  – selection of this function opens the lighting engineering calculation program for interiors and exteriors (large areas, 
roads, tunnels) with view functions of the results tables, graphs and photo-realistic images of the area itself from different points 
of view by means of radiosity rendering and ray-tracing. 

 
Photoview   -  select a product with photometry and choose the Photoview icon to access the photometry management and view 
module with photometric table and graph view and print functions in different languages.  The program will appear empty in all 
other cases. 

 
Lisdat   - selection of this icon accesses the catalog data management module with manual data entry or database import. 

While the second contains: 

 
Manufacturers WebCatalog – selection of this icon accesses the Internet WebCatalog of the active manufacturer (N.B. – the 
active manufacturer is the one whose logo is shown on the right) – please refer to the WebCatalog section of the manual 

 
Parametric Data Update via Internet – this function allows access to the window in which to define the search elements  (product 
parameters) which can be carried out via Internet   

 
Data Plug-in Import – this allows an external data Plug-in (database file) to be imported 

 
WebCatalog – this allows access to the list of available WebCatalogs 

 On the right there is the logo of the company whose product is being shown. Click on the logo to access the company’s data 
window. 

�
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How to perform data search and update  
 Note  

The icons associated with the window have the 
following functions:�

�
Set to Zero – clears previously defined 
fields�

�
Plug-in Update via Web – carries out 
search via Internet on the defined 
search parameters. 

 
This allows you to leave the window 
and return to the main window 

� �

Data Update via Internet  

 

This is activated by selecting the Parametric Data 
Update via Internet  function from the Data menu or 
by clicking on the relative icon. 

The window that appears has 2 parts: 

�� an upper part with the function icons and 
indication of the total number of products found 
in correspondence with the search 

�� a lower part with the TABS corresponding to the 
various parameters that can be used for the 
search. The available data fields for search, 
irrespective of their type, are as follows: 

· fixed fields (fixed choice fields from list): 
these are non editable fields for which it is 
possible to select the description of a 
predefined list such as, for example, the 
color field  

· free fields: these are editable fields for which 
a numerical or alphanumerical description 
can be entered;  in the first case the 
numbers are entered and search can be 
effected using the operation keys (>, <, =, * 
(included)); in the second a description 
(string) is entered and the search is carried 
out on all the visualized elements that 
contain it. 

 
Fields definition window 

Functions 

��   to return the fields to zero 

�� to define the search parameters by means of the different sections 
(TABS). 2 different types of fields are available, drop-down fields, from 
which to choose from a list that is already available, or entry fields, usually 
numerical 

��   select the icon to access the data download via Internet 
management window. This window allows selection of: 

· whether the texts and images connected with the individual products 
are to be downloaded 

· whether everything is to be downloaded without confirmation request 
(if not, in the log window nearest the bottom, the program shows the 
total number of products to be downloaded and waits for confirmation 
before proceeding)   

· whether each download is to be confirmed: if this is selected it will be 
necessary to confirm each individual product 

�
The parameter definition window shows 
a series of buttons which, if pressed, 
reveal the symbols ‘=’ – ‘>’ – ‘<’ – ‘<=’ – 
‘>=’ .  These buttons are useful when 
searching for all products with the 
same value (=) as the selected 
parameter or that have greater (>), 
lesser (<), greater and equal (>=) or 
lesser and equal (<=) values 
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How to perform data search and update  
 Note  

 
 

 
�� press Proceed to continue data download, press Cancel instead to exit the 

function 

�� press Skip, after pressing Proceed, if you wish to ‘skip’ download of a 
product. 

��   the program shows the 
total number of Products Found at the end of updating 

��   to exit the function 

�� the program at this point shows the list of products found and downloaded 
from Internet in the Product List in the main window 

The updating window shows the option ‘Show 
operation log’  which, if selected, proceeds to 
visualize the operations performed during the data 
download phase. 



 
 

 

Manuale LITESTAR 4D – Rv00 Pag. 11/25 

 

 

 

 

How to perform data search and update  
 Note  

The icons associated with the window have the 
following functions:�

 
Set to Zero – clears previously defined 
fields�

 

 
Accesses the Web page of WebOxy 
dedicated to the selected manufacturer. 
If the manufacturer is not defined the 
general WebOxy window appears from 
which to choose the manufacturer. In 
this window there are the indications of 
where the Plug-in is available 

 
Accesses  the window from which to 
select the Plug-in to be imported 

 
To exit the window and return to the 
main window 

 

  

Data Plug-in Import 

 

This is activated by selecting the Data Plug-in Import 
function of the Data menu or by clicking on the 
relevant icon. 

The window that appears has 2 parts: 

�� an upper part with the function icons and 
indication of the total number of products 
corresponding to the search found/imported 

�� a lower part with the TABS corresponding to the 
various parameters that can be used for the 
search.   The available fields for search, 
independently of their type, are as follows: 

· fixed fields (fixed choice fields from list): 
these are fields that cannot be edited for 
which it is possible to select the description 
from a predefined list such as, for example, 
the color field 

· free fields: these are editable fields for which 
a numerical or alphanumerical description 
can be entered: in the first case numbers are 
entered and search can be carried out by 
using the operation keys (>, <, =, * 
(included)); in the second a description 
(string) is entered and search is carried out 
on all elements visualizing those that contain 
it 

 
Field definition window 

Functions 

��   to return fields to zero 

�� to define the search parameters by means of different sections (TABS). 2 
different types of field are available, drop down from which selection is 
made from a list that is already available, or entry field, usually numerical 

��   to access the WebOxy page (www.oxytech.it) in which are shown 
manufacturer data (Note: if the manufacturer has been selected in the 
previous step the program shows the relative sheet) and indication of 
where the Plug-in may be found 

�� to obtain the Plug-in on the basis of the indications supplied by the 
manufacturer 

��   to import the Plug-in: 

· select the Plug-in from the selection window 

· confirm to start the import operation (Note: if certain fields have been 
defined in the Field definition window only products corresponding to 
these parameters will be imported) 

 
The parameter definition window shows 
several buttons which, if pressed, 
reveal the symbols ‘=’ – ‘>’ – ‘<’ – ‘<=’ – 
‘>=’ . These buttons are useful when  
searching for all products with the 
same value (=) as the selected 
parameter or that have greater (>), 
lesser (<), greater and equal (>=) or 
lesser and equal (<=) values 
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How to perform data search and update  
 Note  

Data Update via WebCatalog 

 

Selection of the icon opens a window with the list of 
the companies whose WebCatalog is available, i.e. 
the Interactive Electronic Catalog via Internet.. 

 
From WebCatalog to Liswin with just a click (Drag&Drop)  

Manufacturers window for WebCatalog access 

Functions 

�� double click on the name of a manufacturer:  the program automatically 
launches the WebCatalog of the selected manufacturer 

�� search for products by means of the WebCatalog search functions (please 
see the section of the manual related to the WebCatalog) 

�� perform Drag&Drop of the product image selected directly in the main 
Liswin window:  all available data will be transferred to the local database 
and the product will appear in the Product List in the main window  

Please refer to the WebCatalog chapter for 
instructions on the use of this tool  
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Local product search  
  Note  

Tree Search 
Liswin is equipped with a 3 level tree product search 
function, corresponding to 3 different fields, shown in 
the left of the main window. 

This window contains the functions   
that allow you to open tree search on one of the three 
available levels (the levels correspond to different 
research parameters): click on one of the available 
codes to immediately view the product in the product 
list alongside. 

 

�
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Local product search  
  Note  

The icons associated with the window have the 
following functions:�

 
Set to Zero (clears) the previously 
defined fields�

 

 
Carries out product search on the basis 
of the parameters set in the local 
database 

 
Carries out a further search on the 
same set of products found after 
specifying other parameters 

 
Allows you to exit the window and 
return to the main window 

 

  

Product List 
With Liswin the products can also be searched 
through the Product List.  These can be viewed in 2 
ways: 

�� by selecting the manufacturer from the 
Manufacturer dropdown window: all the products 
of the selected manufacturer present in the 
database will thus appear  

�� by using the Parametrical Search function  
(see the description here beside) 

 

The fields of the Products List are: 

�� New – this indicates if the product has recently 
been updated 

�� FOT (Photometry) –  this indicates if the product 
has one or more connected photometries (OXL 
file)  

�� Product Code, Product Description, 
Manufacturer (the data of the selected product 
are shown in the Product Data section in the 
lower part of the window). 

 

List Ordering – any of the columns of the Product 
List can be put in order:  just press on one of the 
column titles; at this point the program proceeds 
automatically to put that column in alphabetical order 
starting from A or Z (by repeatedly clicking)  
considering it as the active column. The triangle 
beside the title indicates the direction of the order  
from greatest to least,   from least to greatest. 

 
Fields and search definition window 

Parametric search functions 

��   to return the fields to zero 

�� to define the search parameters via the different sections (TABS) of the 
fields and search definition window. There are two types of field available, 
dropdown, with which to choose from a predefined list, or entry field, 
usually numerical.  For example: 
· Manufacturer > Goccia Illuminazione (first TAB) 
· Power W > 300 

��   to launch local search on the basis of the parameters set 

�� to define further search parameters should the search not appear to be 
thorough 

��   to launch a further local search  

��   to exit the fields and search definition window  

�� in this way the products found in the Product List section of the main 
window can be viewed 

 
The parameter definition window shows 
several buttons which, if pressed, reveal 
the symbols ‘=’ – ‘>’ – ‘<’ – ‘<=’ – ‘>=’ . 
These buttons are useful when  
searching for all products with the same 
value (=) as the selected parameter or 
that have greater (>), lesser (<), greater 
and equal (>=) or lesser and equal (<=) 
values 
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Local product search  
  Note  

Search from list –  the active column allows search 
of a product by simply typing the first characters: the 
program will automatically go to the first product that 
corresponds to the characters entered.  

 

Status Bar  - The status bar that closes the window 
shows the number of products in the Product table 
and the selected archive.  

 
 

The section that  includes details of technical and commercial data is subdivided 
into groups according to the type of data.  To move from one group to the other 
use the TABS which are in order (Luminaires case): 

�� General Data such as commercial information (code, product description, 
list price …) 

�� Electrical Parameters such as lamp data, insulation class, eventual 
information about batteries 

�� Mechanical Parameters such as IP degree, surface exposed to the wind, 
IK degree 

�� Photometric Parameters such as list of measurements associated with the 
product 

�� Norms Marks such as the list of norms applied to the product and 
conformity marks 

Clicking with the right mouse button on the 
‘Product List’ section of the main window accesses 
the context menu which includes the following 
functions: 

�� Find “CTRL+F” searches a product according 
to the characters entered in the dialog 
window.  By entering a search element the 
program singles out the first product from the 
list with this element (for example: if the 
active column is the entry code 1234.... the 
program will go to the first code 
characterized by 1234...., provided that the 
product with this code is available) 

�� Find Next “CTRL+N” (searches the next 
product  to that found with the Find function),  

�� Data Sheet accesses the management 
module of the data sheet of the selected 
products. 

�� Photometry visualizes, if the FOT indication 
on the left of the product is active, the 
photometry of the luminaire. 

�� Documents accesses the window showing 
the list of documents associated with the 
selected product (PDF, Excel files etc.). 

�� Cancel eliminates the selected product from 
the catalog 

�� Project List adds the selected product to the 
product list on the left of the list, 
subsequently, with the Lisman program. 

�
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How to create and manage a data sheet  
  Note  

Liswin is equipped with a powerful module for managing product 
data sheets with which to view and print product data, images and 
literature.  

It is activated by: 

��   selecting the relative icon or, 

�� clicking twice with the left mouse button on the selected 
product. 

 

The data sheet window shows a series of commands in the upper 
part and to the left and right.  

In the upper part of the window appear the functions: 

�� To scroll through the various pages of the document,  
showing the current page and total number 

�� To manage screen zoom of the document;  it is possible to 
click on the magnifying glass to zoom in or out and also to 
select the view type of the relative window 

�� To launch print out of the document. 

The tool bar situated on the left of the sheet has the following 
functions: 

�� Language: this is a fixed choice field with which to select the 
data sheet in one of the available languages 

�� Paging: the program has 5 different formats of graphic paging 
for data sheets that can also be activated by clicking on the 
spot to the left of each description 

�� Export in PDF: this allows you to export the data sheet in PDF 
format to be viewed with ADOBE Acrobat Reader 

The tool bar situated on the right of the sheet has the following 
functions: 

�� Data Sheet: visualizes the graph of the paged data sheet 

�� Lamps: allows you to choose from the various alternatives of 
lamps connected to the lighting device 

�� Images: with this function you can choose the image to add to 
the sheet.  Selection of the function opens the window in 
which to choose the images to visualize: a maximum of 3 
images can be inserted to be selected from those available 
(up to a maximum of 10). It is possible to insert a smaller 
number of images, for example, if there are 3 available the 
program activates them all but  you need not select them all.   
To enter the image, click on the check box next to the image.  
The number of images depends on what the graphic module 
(data sheet) you are using foresees 

�� Accessories:  this allows you to link any accessories to the 
data sheet 

�� Extra Texts: the program also allows customized text to be 
inserted in the sheet. To do this the fixed choice field must be 
activated and the relative text selected 

�
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How to create and manage a data sheet 

  Note  

 

 

�
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How to create and manage a data sheet  
  Note  

 

 

�
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How to create a specification (metric calculation)  
 Note  

The icons associated with the window have the 
following functions:�

    New to create a new project 

 
Open to open a previously created 
project that has been saved in the 
archive 

 
Save to save the current project 

 Save as to save the current project 
and define the  file name  

 
Close to close the current project 

 
Properties to access the properties of 
the current project 

 
Configuration to access the program 
configuration management section 

Liswin includes the estimate function which is 
activated from the main window by selecting the icon  

 (see the function description here beside). 

The estimate functions include the functions of: 

�� estimate project creation made up of sub-
projects (projects consisting of different sub-
projects as in the case of offices characterized 
by different rooms)  

�� import of project lists from the Litecalc module 
and of those created with the Liswin program 

�� creation of estimates and offers exportable also 
in PDF format. 

 
Estimate function window 

Functions 

�� select Project/New to open the project data insertion window; press OK 
after completing insertion. The project data, in this case, are the general 
project data 

 
�� select Sub-project/New to open the window with which to define the 

elements of the sub-project. Note: a sub-project means a sub-area that 
makes up the whole project, i.e. area 1 of project A 

 
Press OK to confirm. At this point the product list import window appears 
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How to create a product list  
 Note  

The icons associated with the Project 
Management Window have the following functions:�

  To move an element up and down 
the list 

  
To add a new element (+) or  
eliminate one (-).  A  new element is 
added autonomously from the 
databases by means of the special 
window where the code is entered: 
when confirmed the new product is 
added to the list and it is possible to 
complete its data using the fields 
found on the right of the window 

It is possible to create the product list to be imported 
into the estimate module in 2 ways: 

�� through the Litecalc planning module: 

· save the project created with Litecalc 

· import the list in the estimate module by 
selecting Import Project from the Product 
List Import Window 

�� through the Liswin catalog module: 

· select one or more products from the Liswin 
product list (click with right mouse button on 
the selected product and select Add to list 
from the relative context menu). The 
program then proceeds to insert the 
selection in the products List on the right.  
Repeat the operation again for each product 
to be inserted 

· import the list in the estimate module by 
selecting  Import Liswin List from the 
Product List Import Window 

�

�� import the product lists with Litecalc and Liswin 

  
Product List Import Window 

�� select a product (the data regarding it appears in the right hand part of the 
window) and fill in the missing data, adding, if required, the price, discount 
and quantity. 

    
Project Management Window 

 
To access the product lamps and 
accessories section.  When one or 
more accessories-lamps are 
selected they are automatically 
added to the list  
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How to create a product list  
 Note  

 �� Click on the documents to view the specification of the selected products 

 

�
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How to eliminate products in Liswin  
 Note  

Liswin allows elimination of one or two products from 
the catalog (the following operation is not available in 
the management module of the Lisdat catalog);  
selection of this function opens the Products 
Elimination window on the left of the Viewer. 

The product elimination function is activated with 3 
different steps so as to avoid unwanted product 
elimination. 

 
Main window 

Functions 

�� select the icon  to activate the elimination function 

�� select one or more products to be eliminated by clicking on the first product 
on the list and on the last keeping the Shift button pressed or use the Ctrl 
key to select a number of products that are not  in order 

�� press the icon    to add the selected products to the elimination list on 
the left of the main window.  It is also possible to press with the right 
mouse button on the product to be added to the list and select Add to List  

�� press the icon    to eliminate the products from the catalog. 

�
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How to manage a price list with the catalog  
 Note  

The icons associated with the Price List 
Management Window have the following functions:�

 
To import an external CSV  file 

 
To export a catalog in CSV file 

 
To associate a price list to the 
corresponding catalog. Useful when 
there is more than one price list 
available from the same manufacturer 

 
To cancel the selected list 

  

  The Price Lists function allows you to manage 
the products price lists separately from the catalog 
itself; in fact one or more lists, provided they belong 
to the same group of products, can be added to the 
catalog, even at a later date.  

It is important that the codes of the available products 
in the catalog correspond exactly to those in the list: if 
this is not so it is impossible to associate them.  

 
 

 
Price list management window 

Functions 

�� select a manufacturer’s list 

 

�� export the selected list into an external file in CSV format by pressing  

�� open MS Excel and enter the modifications to the file such as adding 
prices or changing the distributor code  

�� save the modified file again in CSV format and quit Excel 

�� import the modifications by selecting  

�� activate the modifications by pressing on  

It is also possible to change the currency on a list 
that is already available: to do this click twice on 
the currency on the right of the window and select 
the new one. Then click on the highlighted 
manufacturer bar and the program asks if it should 
insert a new list: if the answer is affirmative, the 
program adds the new list.  

This also allows you to export the new list in CSV 
format editable with Excel and to have the prices 
immediately at your disposal in the original 
currency so as to bring about the required 
modifications. Once these are concluded the list 
may be newly imported. 
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How to manage the currency  
 Note  

The icons associated with the currency 
management window have the following functions:�

 
To activate the selected currency 

 
To delete the selected currency 

 
To add a new currency 

  

  

Liswin offers a function with which to define the 
currency in which you intend to manage product 
prices. 

The function can be selected by using the icon    
or by selecting the Currency function from the View 
menu.  The window that appears is shown alongside. 

 

 
Currency management window 

Functions 

�� select the currency to be used 

 

�� press    to activate the selected currency:  the currency line will be 
highlighted in red 

�� press X to quit the window, the selected currency will at this point be active 
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How to configure Liswin  
  Note  

The Configuration function opens the window in 
which to define the program configuration parameters 
which are: 

�� Database: this defines the path for finding the 
catalog database 

�� Technical Data Sheet: to configure the elements 
of the data sheet such as whether or not to show 
data groups (click on the bar of the selected field 
and select Yes/No from the drop down menu) 
and the colors of headings and subheadings 
(click on the color and choose the new color in 
the dialog window) 

�� Media: this defines the path (folders) of the 
project objects such as images and texts. These 
are subdivided into Update (the objects 
downloaded by means of updating functions via 
WEB) and Fixed (all the data available on CD-
ROM) 

�� Default Startup: this defines the default 
conditions for table ordering (for New, FOT 
(Photometries), Code, Description and 
Manufacturer) and the type of product (Lighting 
Devices, Lamps ...) 

�� Internet Download: this defines the site from 
which to effect updating. It is advisable not to 
modify this without indication from OxyTech Srl 

�� Products: this indicates the path of eventual 
external support plug-ins (for example for 
exporting documents in Excel format) 

�� Documents: this indicates the path in which to 
save the documents created by the program (for 
example for export of data sheets in PDF). 

 

 
Configuration Window 

��

 


